
 

RELEASE NOTES 
 

GOHFER 2007 SP2 
Release Date: January 26, 2009 

 
GOHFER 2007 SP2 contains all of the updates included in 2005 (SP1 & SP2), 
2007, 2007 SP1 as well as the following updates.   It is necessary to un-
install Version 2005 or 2007 prior to installing Version 2007 SP2.  The 
installer will perform this task for you. 
 
GOHFER.EXE: 

• Modified PDL and storage sensitivity to more adequately represent 
measured data 

• Added variable Vspurt 
• Updated leakoff model to handle relative permeability and damage factors 

more effectively as well as dynamic leakoff and formation controlled 
(CVC) leakoff. 

• Hardwired the fracture shear rate at the perfs to 2000 sec-1 to more 
effectively model shear through the perforations.   Added an internal 
viscosity delay factor to model the viscosity recovery after 
transitioning from the high shear environment to the low shear rate in 
the fracture. 

• Fixed a problem with Proppant type NONE causing screenouts. 
• Fixed a problem with N2 mist and N2 friction. 
• Fixed a problem that arose when gas was placed in the wellbore 
• Fixed a problem with pressure spikes at the start of injection after a 

shut down, primarily with any tortuosity or high process zone stress. 
• The option has been added under Help/Additional Files to create a QLK 

output file upon each simulation.  This is a space delimited ASCII file 
with grid information and proppant identifiers for use with the 
Halliburton Quiklook program.   For each output grid, there is an index 
of the proppant with the maximum concentration in each node, fracture 
width, and cumulative volume lost through each node at the user defined 
print frequency. 
 

WinGOHFER: 
• Log Processing: 

• Added ability to process logs in metric units.  Log processing must 
now be performed in the same units as the input LAS or CSV file.   
Each source curve now has a defined unit type and in unit.  Output 
curve units will match the source file units. 

• Added Scatter Plot capability in order to analyze existing 
correlations or generate new user defined correlations to determine 
associated slope and intercept. 

• Added simple way to edit the output LAS depths via the Tools menu bar 
command or toolbar. 

• Fixed problem with phantom folders in the output column. 

 



• Cursor location pop-up box on the Zone Setup tab now displays both the 
TVD and MD.  This should make marking zones and perforations easier 
based on MD. 

• Each individual grid block on all the grid tabs now reflects the defined 
node aspect ratio.   A value greater than 1 will now result in a grid 
block that is rectangular as opposed to square in an effort to maintain 
the aspect ratio. 

• A horizontal scroll bar has been added to the top of the grid on each 
tab.  This allows the user to scroll along the length of the grid.   The 
grids no longer attempt to display the entire grid on the screen.  This 
should make building horizontal simulations easier. 

• The cursor location pop-up box on each individual grid tab now displays 
the distance from the left edge of the grid and the depth as opposed to 
the previous X/Y coordinates. 

• In the grid tabs, added the separate ability to send the current grid 
picture (screenshot) to MS PowerPoint as well as the full grid picture 
(area of grid that extends beyond the visible screen). 

• Removed warning dialog box after selecting top and bottom depths on the 
Formation Zone Setup & Grid tab. 

• Added Spurt Volume at 1000 md to each fluid in the fluid database. 
• Increased the number of decimal places for K’ in the fluid database. 

 
WinParse: 

• Removed Start/Stop/Skip dialog box when opening a bin file in WinPARSE. 
 
GOHFER Production: 

• Horizontal Simulation Production Calculations – In addition to the 
existing ability to perform the production calculations on vertical 
wells, GOHFER can now perform these calculations on horizontal 
(longitudinal and transverse) simulations.   User now defines the well 
orientation (vertical or horizontal).   Selecting horizontal will 
display additional parameters including: 

o Horizontal Type (longitudinal and transverse) 
o Angle 
o Lateral Length 
o Lateral Vertical Position 
o Frac Contributing Lateral 
o Horizontal Perm ratio (Kv/Kh) 
o Number of Transverse Fractures 
o Treated Lateral Length 

• Added ability to perform production calculations on asymmetric 
simulation.  Added a 2nd red line on output grid data plot in WinPARSE 
in order to bracket the entire frac length.   Frac half length will be 
calculated by dividing the distance between the red lines by 2. 

• The average proppant concentration used for the production calculations 
is averaged over the user-defined net pay height as opposed to the 
entire frac height between the red lines on the output grid data plots. 
 

Sentinel Protection Installer: 
• Included upgrade to Sentinel Protection Installer 7.5.0. 

 
 



 

RELEASE NOTES 

GOHFER 2007 SP1 
Release Date: February 8, 2008 

 
GOHFER 2007 SP1 contains all of the updates included in 2005 (SP1 & SP2), 2007 
as well as the following updates.   It is necessary to un-install Version 2005 
or 2007 prior to installing Version 2007 SP1. 
 

• Network Capability – GOHFER is now capable of working over a LAN (local 
area network) with the use of a network license key.   Network 
capability is limited to network keys containing 2 or more licenses. 
Contact Kevin Svatek at 713-328-2304 or kevin.svatek@corelab.com for 
more information regarding the purchase of a network key. 

• GOHFER installation is no longer limited to the C: root directory.  
GOHFER may be installed to a different drive (network drive for 
example).   All of the installation components must be installed to the 
same desired directory.  Installation default is to the C: drive.   

 
GOHFER.EXE: 

• Implemented a new friction model based on fluid n’ and K’ to replace the 
previous model based on gel loading.   Gel loading has been removed as 
an input and replaced with a friction correction factor (located under 
Show Other Parameters) defaulted to 1.   The sand exponent was also 
removed and replaced with a crosslink delay factor. Crosslinked fluids 
default to 0.1 and linear, Newtonian fluids default 1.0. 

• Added a Tortuosity Prefactor component that is available under the 
Advanced Reservoir Parameters.  This allows the user to input the value 
of tortuosity measured from the step-down test. 

• Added metric units to the RTD file generated from a GOHFER simulation.   
When the user uses depth in meters, the simulated RTD file will default 
to a pre-determined set of metric units for the output variables for use 
in HTG. 

• Added a screenout warning so that a GOHFER simulation will now terminate 
once the fracture treatment screens out and will no longer continue to 
run the remainder of the pumping schedule. 

 
WinGOHFER: 

• Log Processing: 
• If no RHOB is available, VCOAL will default to zero in order to allow 

a VSHALE to be calculated. (This feature only works if VCOAL is known 
to be zero.) 

• Added new correlations PERMEST (permeability calculated using PHIE) 
and PERMLAS (permeability calculated in raw LAS file) to allow the 
ability to compare multiple perms. 



• Added a synthetic Bulk Density correlation (RHOBPHID) from a Density 
Porosity obtainable from a source LAS file (if available).    

• Improved the ability to handle horizontal logs for horizontal 
fracture simulations and added the horizontal distance (HOFF) to each 
log point from the vertical well location.  

• Reduced the options in the calculations box for each output curve to 
reflect only those that are applicable. 

• Fixed a problem with the 1 ½ inch wide plot option display. 
• Added an option to create additional files located under the Help menu 

bar command.  GOHFER will no longer automatically create the .ASC, .OUT 
and .WDT files.   The user may select to create any or all of the files 
for an individual simulation or default to create any or all of them on 
every job. 

• Improved the link between the grids and the processed LAS file.   The 
grids should now always auto-populate when the grids are initialized.  
Any changes made to the processed log after the grids are initialized 
will now be available to the grids via the Read From Log button. 

• Added a tortuosity component discussed in the gohfer.exe section. 
• Implemented new friction model discussed in the gohfer.exe section. 
 

 
WinParse: 

• In conjunction with the screenout warning added to the gohfer.exe, 
WinParse will notify the user of a possible screenout if the actual, 
simulated job time does not match the intended job time, indicating that 
the simulation ended prematurely. 

 
GOHFER Production: 

• Acid Frac Conductivity – When modeling acid frac treatments, WinPARSE 
will now calculate the acid frac conductivity based on the average acid 
reaction width.  For acid fracs containing proppant (100 mesh for 
example), the model will compare the conductivity of both the proppant 
pack and the reaction width and display the dominant producing 
mechanism.    

• Fixed a problem with the Young’s Modulus unit being sent to the 
production simulator.   YM unit is now set to MMpsi. 

• For Oil Reservoirs only – set the default value for Water Production 
(Oil Reservoirs) to 0.1 bbl/bbl. 

 
GOHWIN (1.6.5): 

• Re-added the following GOHWIN objects: 
• CO2Calcs 
• FoamSchd 
• N2Calcs 

 



 

RELEASE NOTES 
 

GOHFER 2007 
Release Date: March 12, 2007 

 
GOHFER 2007 contains all of the updates included in 2005 SP1 & SP2 as well as 
the following updates.   It is necessary to un-install Version 2005 prior to 
installing Version 2007. 
 

• New installation interface that allows GohWin and HalWin users to select 
appropriate components for installation. 

 
GOHFER.EXE: 

• Changed near-well pressure drop calculation to use proppant 
concentration in fracture instead of wellbore to better model screenout 
development 

• Changed leakoff model to improve high-perm cases 
• All fluids should have Cw_1000 set to 0.1 to avoid filter-cake 

formation in Darcy-perm rock 
• New formulation better models viscous-controlled leakoff without 

filter-cake control in soft, high-perm rocks 
• New model allows transition from a filter-cake forming fluid to a 

non-FC fluid during a job 
• Modified PDL and transverse storage to better match observed fracture 

half-lengths from micro-seismic mapping 
• Implemented code changes to restrict growth of unstable fracture 

“fingers”  
 

WinGOHFER: 
• Incorporated new log processing package – GOHFER_LAS.   GOHFER_LAS is 

accessed the same as before via the Log Calculations button in 
WinGOHFER.   This action will launch the sub-application and open 
GOHFER_LAS in new window. 

• Added an auto-populate grid feature when initializing grids.  This 
feature is only available after processing a log (LAS file) in 
GOHFER_LAS.  The Perforation Diameter and Holes Perforated grid tabs 
still require manual entry. 

• Updated with complete suite of metric unit options for all variables.  
Units Settings are accessed via the View menu bar command.   Units 
Settings menu also includes a master unit selector to switch all 
variables to either English or metric units.  Variable units can also be 
adjusted individually. 

• Added Gel Loading units drop down menu on pumping schedule control 
panel. 

• Added a “Clear Schedule” button to the pumping schedule control panel. 
• Changed perf factor calculations to allow for fractional number rather 

than an integer. 

 



• Fixed a problem with utilizing Save, Edit & Run if WinPARSE was left 
open. 

• Updated proppant database. 
 
WinParse: 

• Updated with complete suite of metric unit options.  WinPARSE units will 
reflect unit choices made in WinGOHFER prior to simulation.  Each 
WinPARSE variable contains unit drop down menu. 

• Added metric unit options to the toolbox. 
• Removed CO2/N2/Acid columns from the pumping schedule if these values 

are zero. 
• Applied proppant concentration cutoff value to the baseline 

conductivity. 
• Re-titled Conductivity plot in output grid data to Baseline 

Conductivity. 
 
GOHFER Production: 

• Defaulted Un-stimulated Skin to a value of 5. 
• Updated production calculations to allow user-specified cleanup time 

after frac. 
• Added entries for Initial FCD and CleanupTime. 

 
 
GOHWIN: 

• Removed non-essential and unsupported GOHWIN objects. 
• Updated PDAT 

• Option to perform ACA w/o performing BCA (made ACA events moveable) 
• Defaulted graph templates 

 
 
 
 
 

 
 



 

RELEASE NOTES 
 

GOHFER 2005 Service Pack 2 (SP2) 
Release Date: January 27, 2006 

 
GOHFER 2005 Service Pack 2 (SP2) contains all of the updates included in SP1 
as well as the following updates.   It is not necessary to install SP1 first 
if you have not already done so. 
 
WinGOHFER: 

• Fixed units issue with international version of Windows. 
• Fixed an error to the foam calculations when using the Adjust Schedule 

based on Quality Function to convert an actual surface foam schedule to 
bottomhole. 

• WinGOHFER now checks to see if marked pay is equal to zero.   If so, a 
warning pops up prior to execution indicating that production will not 
run until net pay is marked. 

• Increased the dot size of imported data in the fluid database graphs. 
 
WinParse: 

• Fixed units issue with international version of Windows. 
• Updated so net pay is only calculated over the Area of Interest (grid 

top and bottom). 
• Updated to calculate production over the currently displayed output grid 

data graph.   Therefore, it is now possible to calculate production over 
the zoomed portion of the graph. 

• Added numerical toolbox data to notes section of PowerPoint when 
plotting output grid data. 

• Fixed a calculation problem with the Baseline Conductivity plot.  
• Fixed an issue with tiling of 2 projects open simultaneously. 
• Fixed a problem on the Input Data tab when trying to scale between 2 

very small numbers producing an overflow error. 
• Removed black bar alongside Input Data when sending to PowerPoint. 
 

GOHFER Production: 
• Added the ability to enter a user defined Un-stimulated Skin value. 
• Fixed a problem with a positive value for the Loss of Width caused by 

embedment and Filtercake for the Un-stimulated case. 

 



 

RELEASE NOTES  
GOHFER 2005 Service Pack 1 (SP1) 

Release Date: September 9, 2005 

 
GOHFER 2005 Service Pack 1 (SP1) contains the following updates: 
 
WinGOHFER: 

• Contains AutoSave toggle located under Help menu bar command (a check 
indicates autosave on and no check indicates autosave off)   GOHFER 
remembers the setting for each time you open.   Default is autosave 
on.   This should eliminate the issue requiring users to adjust their 
virus scan exclusions to avoid a slow program. 

• Fixed the error received when performing a Fill Down in the wellbore 
fluid section of the pumping schedule. 

• Fixed the problem with the Adjust Schedule Based on Quality function 
also changing the shut-in time when rate is zero. 

 
WinParse: 

• Winparse now saves the location of the red line (effective frac length) 
on the output grid data to the gohfer file.   Therefore, there is no 
longer a need to reset the effective frac length everytime an existing 
job is opened in WinParse. 

 
GOHFER Production: 

• Fixed a problem with a positive value for the Completely Uncorrected 
Frac Width for the Un-Stimulated case. 

 
 

 


